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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
Curiosity HPC Development Board. Items discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

* The Microchip Website

» Development Systems Customer Change Notification Service

» Customer Support

* Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity HPC Development Board as a
development tool to emulate and debug firmware on a target board. The document is
organized as follows:

e Chapter 1. “Introduction to Curiosity High Pin Count (HPC)” — This chapter
contains general information regarding the Curiosity HPC Development Board kit
contents, layout and power source.

e Chapter 2. “Getting Started” — This chapter offers information on how to
program the Curiosity HPC Development Board.

* Chapter 3. “Troubleshooting” — Consult this chapter for troubleshooting
information.

* Appendix A. “Schematic” — This appendix lists the Curiosity HPC Development
Board schematic.

+ Appendix B. “General Notes” — Refer to this appendix for general notes on
using the Click module sockets and the solder blob jumpers.

© 2016-2018 Microchip Technology Inc. DS40001856B-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENT CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o,where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS40001856B-page 6

© 2016-2018 Microchip Technology Inc.




Preface

RECOMMENDED READING

This user’s guide describes how to use the Curiosity HPC Development Board. For the
latest information on using other tools, refer to the MPLAB® X IDE home page:
www.microchip.com/mplab/mplab-x-ide. This resource page contains updated
documentation, downloads and links to other MPLAB X compatible tools, plug-ins and
much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website
is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the website contains the following
information:

* Product Support — Data sheets and errata, application notes, sample programs
and labs, design resources, user’s guides and hardware support documents,
latest software releases and archived software
Curiosity Development Board-specific product support can be accessed via our
website at www.microchip.com/promo/curiosity-development-boards.

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip website at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

» Compilers — The latest information on Microchip C compilers, assemblers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assembilers (including MPASM™ assembler); all MPLAB linkers (including
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object
librarian).

+ Emulators — The latest information on Microchip in-circuit emulators.This
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

* In-Circuit Debuggers — The latest information on the Microchip in-circuit
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3
debug express.

* MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows®
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are nonproduction development programmers such as PICSTART® Plus and
PICkit 2 and 3.

© 2016-2018 Microchip Technology Inc. DS40001856B-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:
« Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the website at:
www.microchip.com/support.

REVISION HISTORY
Revision A (July 2016)

Initial release of this document.

Revision B (August 2018)

Updated Appendix B.
Other minor editorial updates.
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Chapter 1. Introduction to Curiosity High Pin Count (HPC)

The Curiosity High Pin Count (HPC) Development Board supports Microchip’s 28- and
40-pin 8-bit PIC™ MCUs. Two unique PDIP sockets are surrounded by dual-row
expansion headers, which allow for connectivity to all pins on the PIC MCUs.
Programming/debugging is accomplished through the PICkit™ On-Board (PKOB),
eliminating the need for an external programming/debugging tool. The development
board includes a set of four indication LEDs, a potentiometer, and push-button
switches. Additionally, the Curiosity HPC Board integrates two MikroElektronika
mikroBUS™ sockets, which accommodate a variety of plug-in Click™ Board modules
that can be used for application development.

1.1 CURIOSITY HIGH PIN COUNT (HPC) DEVELOPMENT BOARD KIT
CONTENTS

The Curiosity High Pin Count (HPC) Development Board kit contains the following:

* Curiosity High Pin Count (HPC) Development Board
* Quick Start Guide
» PIC16F18875 MCU

© 2016-2018 Microchip Technology Inc. DS40001856B-page 9
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FIGURE 1-1: HPC DEVELOPMENT BOARD
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. USB micro connector

. 3.3/5V power jumper

. Master Clear Reset button

. Dual-row expansion headers

PIC® MCU socket for 28-pin microcontroller
. PIC® MCU socket for 40-pin microcontroller
. mikroBUS™ Click Board socket 1

. mikroBUS™ Click Board socket 2

. Push button SW2

10. Push button SW1

11. Potentiometer
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Chapter 2. Getting Started

The Curiosity HPC Development Board can be used with either MPLAB® X Integrated
Development Environment (IDE, version 3.0 or higher) or MPLAB® Xpress IDE; both
IDEs are available for free at www.microchip.com.

The Curiosity HPC Development Board contains a PICkit On-Board (PKOB) which
allows for both low-voltage programming and low-voltage in-circuit debugging for all
supported devices. When used with the MPLAB IDE, in-circuit debugging allows the
user to run, modify, and troubleshoot their custom software and hardware quickly,
without the need for additional debugging tools.

21 PROGRAMMING THE CURIOSITY HPC DEVELOPMENT BOARD

Programming the Curiosity HPC Development Board can be accomplished through
one of the two following ways: either through MPLAB X (version 3.30 or higher), or
through MPLAB Xpress.

Note: The Curiosity HPC Board must be programmed using Low-Voltage
Programming (LVP). The LVP bit of the Configuration Word(s) must be set
(LVP =ONor ‘1).

211 Programming Using MPLAB® X

1. Connectthe Curiosity HPC Board to the computer using the on-board micro-USB
connector.

2. Open MPLAB X and either create a new project or open an existing one.

3. Click on the Project Properties icon located in the project’'s Dashboard window
(as seen in Figure 2-1). Alternatively, the Project Properties window can be
opened by clicking on File > Project Properties, or by right-clicking on the project
name in the Projects window and clicking Properties.

© 2016-2018 Microchip Technology Inc. DS40001856B-page 11
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FIGURE 2-1:

PROJECT PROPERTIES BUTTON

0

-

HPC_Masters_Demo - Dashboard 2 |

274) %4 HPC_Masters_Demo
%4 Project Type: Application - Configuration: default
Device
PIC16F1719
-8 Checksum: 0x99A1
=5 Compiler Toolchain
T XC8 (v1.37) [C:\Program Files (x86)\Microchip\xcs\v1.37\bin]
: Production Image: Optimization: +speed +asm
“H License: Workstation - PRO - HPA:6308 day(s) - Press for Status
= Memory
i) Usage Symbols disabled. Click to enable Load Symbols.
-5 Data 2048 (0xB00) bytes
{ 210, |
Data Used: 434 (0x1B2) Free: 1614 (0x64E)
Program 16384 (0x4000) weords
65%

EEEES

—1-#§ Debug Toal

€D Starter Kits (PKOB): MTI160890005
[=+il Debug Resources

‘0 Program BF Used: 0 Free: 1

‘O Data BP: No Support

0 Data Capture BP: No Support

-0 unlimited BF (S/W): No Support

’]

4. The Project Properties window will open. This window allows for the selection of
the programming tool, compiler, and PIC MCU. MPLAB X refers to the Curiosity
HPC Board as ‘Starter Kits (PKOB)’, with ‘Curiosity’ listed below in the Hardware
Tool selection window. Click on Curiosity to select the Curiosity HPC Board,
then click the Apply button (as seen in Figure 2-2).

DS40001856B-page 12
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FIGURE 2-2:

SELECTING THE CURIOSITY HPC DEVELOPMENT BOARD

] Project Properties - HPC_Masters_Demo

==

Categorie

@
@
=]
@
=]

5.

@ General
2 File Inclusion/Exclusion

Conf: [default]

Starter Kit (PKOB)

Loading

Libraries

Building

XC8 global options
~ 2 XC8 compiler

e 0 XC8 linker

Manage Configurations...

Configuration
Family:
All Families

Supported Debug Header:

None

Hardware Tool:

Device:

. PIC16F1719

Supported Plugin Board:

i MNone

Compiler Toolchain:

. Hardware Tools
-0 ICD 3
@ PICKIE2
-0 PICKIt3

= PM3
-0 Real ICE
Simulator

[Z+mpasm

. Compiler Toolchains

-~ mpasm (v3.66) [C:\Program F
~@ mpasm (v5.65) [C:\Program |

11

R

é"XCEI

@ mpasm (v5.64) [C:\Program f| _
-2 mpasm (v5.62) [C:\Program f —
-2 mpasm (v5.62) [C:\Program f

B <C8 (v1.37) [C:\Program Filef
-2 ¥C8 (v1.36) [C:\Program File:

2 XC8 (v1.35) [C:\Program File:
-2 XC8 (v1.34) [C:\Program File:

1 T Tl M il

| }

XC8 (v1.33) [C:\Program File: —

*Tip: double click on serial number (SN) to use a friendly name (FN) instead.

[ ok

H Cancel ]( Apply )]

Unlock

i

FIGURE 2-3:

5. In the upper left-hand corner of the Project Properties window, click on Starter
Kits (PKOB). The window will now show the configuration options for the PKOB

programmer, as shown in Figure 2-3.

PROGRAM OPTIONS FOR THE PICkit™ ON-BOARD (PKOB)

] Project Properties - HPC_Masters_Demo

——

=

L= =R s =}

Cateqgories:
¢ @ General
2 File Inclusion/Exclusion

&S tarter Kit (PKOB) Y,
1g

Libraries

Building

XC8 global options
@ XC8 compiler
@ KC8 linker

Manage Configurations...

Options for Starter Kit (PKOB)
Option categories: :Memories to Program |
uto select memories and ranges  Allows PICKt 3 to Select Memories v
Configuration Memory
D
Frogram Memory
Program Memory Start (hex) 0x0 =
Program Memory End  (hex) 0x3fff
Freserve Program Memory D
Preserve Program Memory Start (hex) 0x0
Preserve Program Memory End  (hex) Ox1f -
Option Description
o] (_concel ) [_zonh
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6. Inthe Option categories drop-down menu, select Program Options; ensure that
the Enable Low Voltage Programming check box is checked (Figure 2-4). This
option should go default to checked, which ensures low-voltage programming.
Click the OK button. The Curiosity HPC Board is now ready to be programmed.

FIGURE 2-4: ENSURE LOW-VOLTAGE PROGRAMMING IS ENABLED
[ 1] Project Properties - HPC_Masters_Demo M1
C!afegori;es;eral Options for Starter Kit (PKOB)

i @ File Inclusion/Exclusion

= < Conf: [default]

1>

-+ @ Starter Kit (PKOB) Erase All Before Program

@ Loading CEnable Low Voltage Programming
-+ @ Libraries

- @ Building

f—] @ XC8 global options
i @ XC8 compiler
e @ XCB linker

Option Description

Manage Configurations...

| 0K H Cancel H Apply ] Unlock

7. Once the project is ready to be programmed, simply click on the Make and
Program Device button, and MPLAB will build and compile the code and
program the PIC device, as displayed in Figure 2-5.

FIGURE 2-5: DEVICE PROGRAMMING

Eile Edit View Navigate Source Refactor Run Debug Team Tools Window Help Q- Search (Ctri+I)

i 8 \default - D B -G Ff - & e oesic] | zdec im0 bank1| (& (Howdo

3 113:47
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2.1.2

1.

Programming using MPLAB® Xpress

Connect the Curiosity HPC Board to the computer using the on-board micro-USB

connector.

Type the link to the MPLAB Xpress IDE

(http://www.microchip.com/mplab/mplab-xpress) into a browser window.

Create a new project or open an existing project.

At the very bottom of the MPLAB Xpress window, click on the label USB Bridge
Disconnected (Figure 2-6); a new Manage USB Bridge window will open.

CONNECTING THE USB BRIDGE

FIGURE 2-6:

3 IDE - MPLAB Xpress x §_§

File Edit View Navigate Source Run Debug Tools Window

O Program BP Used: O Free: 1

€« C' https://mplabxpress.microchip.com/mplabcloud/ide

= Cny | BR . Gog . .
FPEHES D¢ @T-B P -B[xow
Project 9 maine x
a5 test 1~y

2
({5 Header Files 3
A [Ej Source Files ;
1.1 main.c 6
: ’
b ] humidity.c 8 #include "main.h”
; - 9
= .
18 main()
Dashboard 11-
. 12 init();
25 | '8 test 13 while(1)
P 14 - c
| Device 15 Humidity();
= @ PIC16F16855 1s }
@ _ Ty
4~ ' Compiler Toolchain 18
P e 19 void init(void)
f O X8 (1.35) 0 ¢
, 21 OSCFAQbits.HFFRQ = BbA161;
o £ Memory t
[ Memory 22 0SCCONLbits.NDIV = @b8esl;
4~ &% Debug Tool 23 ANSELC = ox@0;
Lo 24 TRISCHits.TRISCS = 1;
[ @ Frckit3 25 TRISCbits.TRISCA - 1:
4. §Tf Debug Resources 26
L @ Data BP: No Support Output x

© Debugger Connected(C @ USB Bridge Disconnected ) @ Programming Tool Disconnected

TemsPrivecy 111 TrAnsim
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5. The new window configures the USB connection between the computer and the
Curiosity HPC Board (Figure 2-7). Step 1 indicates that the latest Java Runtime
Environment must be installed, allowing the user to download and install the
latest version. Step 2 opens the bridge tool; click on the Download USB Bridge
Tool button to download the bridge tool. A new window, MPLAB Xpress USB
Bridge will appear, and may ask for the unique token found in Step 3 in the
Manage USB Bridge window. Copy and paste the token into the USB Bridge tool.
Once connected, the Bridge tool will show the connection and the words
“Everything is looking good.” will appear (Figure 2-8). It is important to note that
the Bridge Tool window must remain open while working on the project. Click the
OK button in the Manage USB Bridge window.

FIGURE 2-7: MANAGE USB BRIDGE WINDOW

S IDE - MPLAB Xpress x %%
&« C & https://mplabxpress.microchip.com/mplabcloud/ide 97 =
File Edit View Navigate Scurce Run Debug Tools Window Links =
= Er O .

PEGES D@D T - bF-E5[cow

ooiect | Manage USB Bridge “ DS
Ao [ test

ﬁ Header Files In order to debuag a real device, you have to start and connect the USB Bridge tool

The USB Bridge requires Java 8 to be installed. Please follow these steps to install and connect

A Source Files
E the USB Bridge.

1 main.c
------ &) humidity.c
L ( STEP 1 1 STEP2
Dashboard ] q_{) ; -
. =
e %3 test — |
o . Gonice | s T
. Download USB Bridge Tool
@ @ PICI6F18855
“l e ) ’ Which version do | have installed? More Information
4 T Compiler Toolchain
: H xce(135)
o (5 Memory
427 Debug Tool STEP 3
6P1Ck1t3 Enter or paste this unique token into the USE Bridge to -
R 4
4~ ff Debug Resources 38f08095-4a08-4933-9504-707 00722480 ﬁ

O Data BP: No Support

@ Program BP Used: 0 Free: 1

Ok
@ Debugger Connected @ USB Bridge Disconnected @ Programming Tool Disconnected Terms Privacy 1)1 Transim’
FIGURE 2-8: MPLAB® Xpress USB BRIDGE WINDOW
|45 MPLAB Xpress USB Bridge [P
File Help

This USB Bridge provides connectivity between your Microchip programming tool and MPLAB Xpress.
This tool needs to stay open and connected.

i
i

Everything is looking good.
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6. Click on the Project Properties icon located in the project’'s Dashboard window
(Figure 2-9). Alternatively, the Project Properties window can be opened by
clicking on File > Project Properties, or by right-clicking on the project name in
the Projects window and clicking Project Properties.

. ®
FIGURE 2-9: SELECTING THE CURIOSITY HPC IN MPLAB™ Xpress
[ - I )
S IDE - MPLAB Xpress x % %
L o C 3 https://mplabxpress.microchip.com/mplabcloud/ide e =
File Edit View Navigate Source Run Debug Tools Window Links =
a1 | GR o GRa . .
PSS D@ DT -8 b % Bl
Project B maine x =
A [ test ; -}
(- [E3) Header Files 3
- [33) Source Files =
E’]n'a\r\c g
E‘ humidity.c 8 #include "main.h"
[ - 9 ]
1@ main()
Dashboard 11-{
- 12 init();
2% )% test k] while(1)
i e 14~ {
-3 "'“@De"‘e 15 Humidity();
@ L gt FIC16F18855 ig ) i
: "E‘,' Compiler Toolchain 18 I
S PR 19  void init(void)
L O wes (138) 2~ 1
’ 21 OSCFRQbits.HFFR) = @bal1al;
& Memory 22 0SCCONLbits NOTV = @08a81;
- 2% Dabug Tool 23 ANSELC = @x00;
: 24 TRISCHits.TRISCS = 1;
b @ PICKIL 3 25 TRISCbits.TRISCA = 1: %
- 26 4
- {§ Debug Resources
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7. The Project Properties window will open; this window allows for the selection of
the programming tool, compiler, and PIC MCU. MPLAB Xpress refers to the
Curiosity HPC Board as ‘Curiosity’, with the Curiosity HPC serial number listed
below in the Hardware Tool selection window. Click on the serial number to
select the Curiosity HPC Board, then click the Apply button (Figure 2-10).
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FIGURE 2-10: SELECTING THE CURIOSITY HPC IN MPLAB® Xpress

3 IDE - MPLAB Xpress x § %

&« C' & httpsy//mplabxpress.microchip.com/mplabcloud/ide
File Edit View Navigate Source Run Debug Tools Window Links =
| T T, -
PEHBY DCED T B b Blcw
S =
Par=y roject Properties
- [iE] Header F| | Categories: — Configuration
a E Source Fi H
ido
% i S EEEeT Family: Al Families v Device: | PIC16F18855 N
e O Starter Kit (PKOB)
> Bui
Building Hardware Toal: Compiler Toolchain: |
—_— | @ XGCB compiler
Dashboard 1] Hardware Tools L] Compiler Toolchains
" - few @ XC8 linker : : alization
o | % test fm 00 PICK] 4~ [[] XCB
bl G Device 4/7Co Curiosity -0 XC8 (v1.34) o the HTU2ID 1
@ @ Pl L~ SN MTI160890005 -@ XC8 (v1.35)
- Compils L G SiMUIGtr / Xpress Board L] mpasm |
L G g e mpasm (v5 64)
(5 Memony - .
- 2% Debug | E
& cu %
2
3% Debug
i O D
b @ Prg
Ok Cancel Apply
TT
2 Debugger Connected @ USB Bridge Connected @ 1 Programming Teol Connected TermsPrivacy 111 Transim

8. In the upper left-hand corner of the Project Properties window, click on Starter
Kit (PKOB). The window will now show the program options for the PKOB.
Ensure that the Enable Low-Voltage Programming check box is checked
(Figure 2-11) and press the OK button. The Curiosity HPC Board is now ready to
be programmed.

FIGURE 2-11: ENSURING LOW-VOLTAGE PROGRAMMING IS ENABLED
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9. Once the project is ready to be programmed, simply click on the Make and
Program Device button and MPLAB Xpress will build and compile the code, and

program the PIC device (Figure 2-12).

FIGURE 2-12: PIC® DEVICE PROGRAMMING
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Chapter 3. Troubleshooting

This chapter discusses common operational issues and methods to resolve them.

3.1 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity HPC Development Board’s PICkit On-Board (PKOB) uses low-voltage
programming. Both MPLAB X and MPLAB Xpress set the Low-Voltage Programming
(LVP) bit to a ‘1’, allowing low-voltage programming.

1. When using custom firmware, the LVP bit must be set to ‘1’ in the Configuration
Word. MPLAB X will not allow programming using the PKOB unless the bit is
properly configured.

2. When using a PIC microcontroller (one not included with the Curiosity
Development Board) that has already been programmed using high-voltage
programming and the LVP bit is cleared (LVP = OFF or ‘0’), the device will not be
recognized and cannot be programmed using the PKOB. Reprogramming the
device can be achieved by one of the following two methods:

a) Connect a PICkit™ 3 Programmer to the PIC device dual-row expansion
headers, ensuring the appropriate ICSP™, GND, and VDD connections are
made. Configure MPLAB to use the PICkit 3 as the programmer, and ensure
the LVP bit is set to ‘1’ in the Configuration Word. Reprogram the device.

b) Use an unprogrammed (blank) device and ensure the LVP bit is setto ‘1’ in
the Configuration Word.
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Appendix A. Schematic

A1 CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC

FIGURE A-1: CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC (1 OF 2)
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10SI

Cur

CURIOSITY HPC DEVELOPMENT BOARD SCHEMATIC (2 OF 2)

FIGURE A-2
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Appendix B. General Notes

B.1 mikroBUS™ CLICKS

Module 1 is the main click socket, and Module 2 is the secondary socket. Both sockets
are fully compatible with a 40-pin PIC device; however, when using 28-pin devices, not
all pins are available.

All pins in Module 1 are available for use with the exception of the mikroBUS's Reset
(RST) signal, which is tied to pin RDO. PORT D is not available on 28-pin devices. If
the RST signal is needed, remove the solder blob jumper associated with the
mikroBUS RST connection, and place a jumper wire between the via next to the solder
blob jumper and the desired pin connection found in the J8 or J11 dual-row expansion
headers (see Figure 1-1).

All pins in Module 2 are available for use with the exception of the mikroBUS's Reset
(RST) signal (RD2), SPI Chip Select (CS) signal (RD3), and the PWM (RD1) signal.
These signals are routed to the PORT D pins, which are not available on 28-pin PIC
devices. If these signals are needed, remove the solder blob jumpers associated with
the mikroBUS connection pins, and place jumper wires from the vias located next to
the associated solder blob jumpers to the desired pin connections found in the J8 or
J11 dual-row expansion headers (see Figure 1-1).

B.2 SOLDER BLOB JUMPER

Solder blob jumpers can be found on each Click module, push-button switch, LED, or
potentiometer connection. This allows the user to utilize those pin connections for other
applications.
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